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I - About the Planner 

This Section of the Planner's manual addresses all the steps necessary for the creation of 

an activity, for either practice or evaluation purpose. It covers the different types of items 

that can be created, how to create them, the media that can be included in each of them, 

and the different settings that can be applied to these items to change their behaviour.  

For clarity purposes, we have defined the following words in this manual as:  

• Planner is the function that allows you to create an activity.  

• Activity refers to the final product, such as a lesson or a test. It includes a list of 

items or exercises.   

• Item refers to an element such as an exercise, which will be presented to the 

students and may require an answer,  

• Content is the media added to an item such as text, audio, images.  

• The menu layout or plan is the visual organization or grouping of items in the 

activity’s menu.  

II - Before You Start 

Adding the New Activity in the Main Menu 

The System Supervisor (Master ID) is the only user who can add a new entry in the main 

menu. When instructors wish to create a new activity, they must first contact the System 

Supervisor, specify the activity’s title and its location in the main system menu.  

This new entry can be placed in the Instructor's menu while it is being worked on to 

prevent students from accessing it until it is ready. Once completed, the system 

supervisor can move it to the students' menu. Alternatively, the new activity can also be 

created directly in the students' menu and set to Wait to Start until it is ready to be 

published. As soon as the menu entry is added, the instructor can enter the Planner and 

proceed with building the plan.  

Preparing for Recording 

It is worthwhile creating quality recordings. In order to ensure that the recordings are the 

best possible, the following instructions are suggested. 

• Always use a good quality microphone.  

• Ensure the environment you are recording in is quiet.  

• Place the microphone as far as possible from the computer to minimize noise 

from fans or other devices.  

• While recording, observe the volume graph and ensure that the sound shows 

approximately three quarters of the total height of the graph.  

• Review and edit the recording to minimize pauses and noises at the beginning and 

end.  
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Getting the material ready 

If you plan to import audio files or images, make sure they are in the correct format and 

located in a convenient place to speed up the import process. Having these files in an 

easily accessible folder will simplify the steps.  

 

• Audio files formats must be .mp3, .wav, .wma  

• The images should be .jpg or .bmp with a maximum size of 240 H x 320W  

II - The Layout 

It is important to get familiar with the Planner's interface before you start authoring. The 

Planner interface resides within the main interface. Which means that some of the tool 

bars you will see belong to the general interface and are always displayed, from the 

moment you sign in, while some will belong to the planer only and are displayed only 

when you open the Planner.  

The Function Bar  

The Function Bar is part of the general interface and is available at all time. Every time 

you open a lesson in any mode (Planner, Player, and/or Tracker) a corresponding tab will 

show in the Function Bar. This allows you to toggle between 2 lessons or 2 lesson 

functions.  

 

 
 

It is therefore important to be able to identify each tab right away, to avoid any confusion 

or delays.  

 

To help you identify your Planner, each tab shows:  

 

• The title 

 

In this illustration, the lesson is named Leave/Live.  

• The function 

 

 

The icon located on the left of the tab identifies the 

function (mode) of that lesson. This icon represents a 

Planner tab. It is a smaller simplified version of the 

Planner icon located in the Tool bar of the main interface.   
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• The tab's status  

 
 

 

 

  

 A blue tab indicates that it is active. This is the planner 

currently displayed on your screen. There can only be 

one blue tab.  

 

A grey tab indicates that although this planner is open, it 

is inactive. If you wish to display this Planner to add or 

edit an item, you must first click on this tab to activate it. 

The tab will become blue and the content of the Planner 

will be displayed. There can be up to 6 inactive tabs in 

your Tab Bar.  
     

The Tool Bar  

The Tool Bar is always visible as part of the general CAN-8 interface. It allows access to 

the different lesson modes. The icons in the Tool Bar are shortcuts to the main functions 

of CAN-8. They are linked to:  

 

 

 

Displays the main menu and its entries to select a function or a lesson  

  
 

The Player or student program - to play an existing lesson as the students 

will see it   
 

The Tracker or monitoring screen - used to monitor students' progress 

through a lesson   
 

 

The Planner or authoring screen - to design and create lessons   
 

 

The Phone to contact online students.  

 

III - The Planner's Interface  

It includes  

• The Planner Tab Bar, where up to 8 tabs can be displayed.  

• The lesson Tree Menu, where the list of items forming the lesson is displayed.  

• The Work Area, where text, images and video can be placed.  
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• The Volume Display, where the graphic representation of the recorded or 

imported sound will be shown.  

• The Audio control buttons  

 
 

 

  NOTE 

It is important to be familiarized with the layout of this interface and the names 

that have been given to each area of the Planner as they will be referred to all 

along this chapter.  

 

1. The Planner Tab Bar 

The Planner tab bar is located below the Function bar, right above the Work Area. 

 

When a lesson's Planner is first opened, the Planner tab bar is empty. As the items are 

being created and edited, tabs (up to a maximum of 8) are added. 

 

Each item tab shows the item's title and the icon corresponding to the item's type.  

 

 

Grey tabs correspond to items that are open but not displayed.  

 

When the content of an item is displayed in the work area, the tab 

becomes active and turns orange.   
 

Below is the tab bar of a Planner being edited: 
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The upper bar shown is the Function Bar. In this example, the instructor opened 

simultaneously the Player (student screen), the Tracker and the Planner of the lesson 

named Leave/Live. The active tab (highlighted blue) indicates that this lesson is opened 

in Planner mode (or editing mode).  

 

The bar below is the Planner Tab Bar. 8 tabs are present, each corresponding to one item 

being edited. In this example, each item is of the same type as indicated by the icon in the 

tabs. The tab highlighted orange is the active tab and corresponds to the item currently 

displayed in the work area  

 

A maximum of eight items can be simultaneously opened for editing. The Planner Tab 

Bar will therefore display up to eight tabs only.  

 

 

When attempting to open more 

than eight tabs, a system warning 

will show. Select OK in the 

warning window, and then close 

one or more tabs in order to open a 

new one.  

 

  NOTES: 

• To toggle between items, click on the corresponding tab recognizable by its name.  

• To close a tab, click on it to highlight it and then select the Exit button at the far 

right of the Planner Tab Bar. Repeat these steps for each tab you wish to close.  

 

2. The Tree menu 

The tree menu displays the layout of the lesson and allows navigation through the 

lesson's items. 

 

When the Planner is first opened, this menu is empty. As items are added, their title, their 

type and the mark assigned (if applicable) are displayed, as illustrated.  
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• Type: The type of each item (represented by a unique icon) specifies the purpose 

of the item, its presentation, and what is required of the student.  

• Title: The title of an item contains 14 characters. This title is used to name the 

item in the menu of the student player and in the lesson Tracker.  

• Mark: Items may be assigned a mark of 1 to 10 using their Properties box. Not 

all items require a mark or can be marked. Introduction, Teach and Conversation 

items cannot since they require no input from the students.  

•  

 

  NOTES: 

• Empty items listed in the Planner menu will not show in the students' menu.  

• As the Planner is being created or edited, you may notice that the title and 

background colour of the items, in the tree menu and in the tab, change colour. 

This is meant as a visual help while editing a Planner but does not require to be 

memorized.  

TEXT COLOUR:  
GREEN: Opened item - has not been changed. 

    RED :  Opened Item - has been changed.  

TEXT BACKGROUND COLOUR:  

:  Saved without changes.  

:  Saved with changes.  

:  Empty item.  

 

3.The Work Area 

The work area is where the content (text, graphics, videos) will be added or edited.  
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Work areas may differ in appearance depending on the item type. Certain item types may 

not show all areas. 

4. The Volume Graph 

The volume graph displays the graph of the audio that has been recorded or imported in 

the exercise. It includes:  

 

 

A red cursor: 

    

The cursor moves through the volume graph as the sound plays. You can click anywhere 

on the sound graph to move the cursor and play the audio from that point forward. For 

editing purpose, this is used to synchronize the text with the sound, to edit or snip part of 

the sound.  
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The sound graph.  

    

It is the graphic representation of the sound. This allows the user to visualize breaks in 

the sound for editing purpose. The vertical axis represents the loudness. Care should be 

taken when recording or importing sounds that the height of the green bars does not 

exceed or touch the first blue line from the top of the graph to avoid noises unrelated to 

the actual audio.  

The volume graph may be used: 

• to synchronize sound and text  

• to snip audio  

• to set the timers  

A counter display. 

 

It indicates the position in seconds of the red cursor within the audio graph. 

The volume graph buttons 

  

They are highlighted blue when active. You can either click on them or use the keyboard 

function keys.  

IV - Building a New Activity 

There are four basic steps to create an activity:  

• opening the Planner, as items can only be created from within the Planner.  

• adding items to the menu to create the structure needed,  

• adding content to each of these items. This can be done as each item is created or 

after all the items have been laid out in the Planner's menu.  

• saving the Planner. Only then does the Planner become accessible to all other 

users.  
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The plan can be changed/edited at any time; items can be added, and the content of each 

item adjusted. Items may be copied or moved from one plan to another.  

This section will guide you through the steps required to create a generic plan.  

  NOTE: 

The activity must be created in the main menu by the system supervisor before 

continuing with the steps below. See Previous chapter. 

 

1 - Opening the Planner 

A Planner can be accessed using any of the following methods:  

From the Menu Bar 

 

Select an activity in the Main menu, then File - Plan Item in the top menu bar. The 

planner will open  

  NOTES: 

• The lesson must first be selected in the menu (click once on it - title highlighted) 

or the Plan Item option in the drop-down menu is greyed out.  

• Only lessons have a Planner. If you selected a submenu or an application, the 

Plan Item option will be greyed out  

...  

From the Contextual Menu 

 

Right click on an activity in the main tree menu. This will bring up the contextual popup 

menu. Select the option Plan Item.  
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Using the Tool Bar Icon 

 

Located in the Tool Bar on the left side of the tree menu. This icon is only available to 

users who sign in as instructor or master. Click once on this button to open the Planner.  

  NOTES:   

• You must select an activity first or these 3 options will be disactivated. If don’t 

select one, or if the menu entry selected is not a CAN-8 lesson but some other 

menu entry type, like a submenu for example, these options remain greyed out.  

• Once the Planner is opened, a tab corresponding to that Planner will show in the 

function bar.  

• Users who are new to CAN-8 can familiarize themselves with the several item 

types available before reading the next section.  

 

2 - Adding Items to the Planner's Menu 

An instructor can create up to 11 different types of pre-defined items that can include 

different components, like audio, text, graphics, and video. We will address the 

components of each of these items all throughout this chapter as we go through the 

creation process and details of each item type.  

 

Each item type has been assigned a unique icon to make navigation through the lesson 

clearer.  

 

The table below shows the icons, their corresponding item types, the available 

components for each item and a brief description. To view a sample of the item, and for 

more detailed information about the item type, click on the corresponding link in the Item 

Type column.  
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Icon 

 

Item Type 

 

Components 

 

 

Introduction audio and graphic only 

 

Requires no input from student  

 

Teach Item  audio, text, graphic, video  

 

Requires no input from student 

 

Example  audio, text, graphic, video 

 

The Student is required to record an oral response 

 

Verify  text, audio, graphic, video 

 

The Student is required to record an oral response 

 

Simultaneous  text, audio, graphic, video 

 

The Student is required to record an oral response 

 

Ask/Answer  audio, text, graphic, video 

 

The Student is required to record an oral response 

 

Read/Record  text, graphic, video 

 

The Student is required to record an oral response 

 

Multiple-Choice  audio, text, graphic, video 

 

The Student is required to select an answer 

 

Fill in the blanks  audio, text, graphic, video 

 

The Student is required to type a written response 

 

Write/Dictation  audio, graphic, video 

 

The Student is required to type a written response 

 

Conversation  audio only 

 

This item requires no input from the student 

 

Disabled Item  audio, graphic, text, video 

 

This item is hidden from the student 

 

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/plannerm.html#i0022
file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/plannerm.html#i0021
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  NOTE: 

Items can either be created new by the instructor as part of their lesson design or 

can be copied from an existing Planner and then edited for the purpose of the new 

lesson.  

Create a New Item 

 

• Locate where you wish to place or insert the item.  

• Right click on the existing item under which the new item should be. A horizontal 

cursor will appear where the new item will be placed.  

• In the drop-down menu select New. This will open another drop-down menu.  

• In the list presented, select the type of item you wish to insert.  

• Once you select the type, the new item is added.  

In this illustration, a Conversation item will be inserted under the Teaching item. 
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Once you select the type, the new item is added. The title can be changed at creation or 

later.  

 

  NOTE: 

Changes to this item such as the item type, item name, item mark, and item 

specific options can be done once the item is created via the item's Properties 

dialog box. 

 

To open an item's Properties dialog box, right-click on the item in the menu and select 

Properties from the popup menu:  

 

• To change the item type, click on the radio button corresponding to the type.  

• To edit the item name, click on the Item Name. field and type the new name.  

• To assign a mark, select the total mark to be assigned in the drop-down menu of 

the Item Mark. field.  

• Depending on the type of item selected, more options are available, like Part 

Marks, Match Case and Randomized Answers.  

• Select OK when the changes are done.  
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    NOTES: 

• If you chose the type Disabled, the item will show normally in the Planner's tree 

menu but will not show at all in the students' menu. The content of the item is 

preserved in the Planner until the item is activated (a type is specified).  

• Similarly, empty items show in the planner's menu but do not show in the 

students' menu either. You must add at least 1 component (text, audio, image) for 

the item to show. Follow this link to add content to your items  

 

Creating items by dropping content into the menu 

You can also create items by dropping either audio, text or an image directly into the 

Planner's menu. This content can be dragged from a file accessible on the system, from a 

browser, or it can be dragged directly from another CAN-8 item located in the same 

lesson or in a different lesson.  

The procedure is as follow:  

From a file 

 

• Open a Planner  

• Locate and select an audio file or text file on the drive (local, external, network or 

removable drive)  

• Drag the file directly from the drive into the Planner's menu holding the mouse 

button down.  

Drop the file in the menu by releasing the mouse button. If the file is an audio file, as 

soon as the button is released, a mini volume graph window appears and displays the 

progress of importing the sound. For text files, the item is created directly.  
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NOTE: 

The newly created item will be Disabled and titled New Item. To rename it and 

enable it, follow the same procedure than for a new item.  

From an existing CAN-8 item  

You can select some audio or some text from another existing CAN-8 item (located in the 

same or in a different Planner) and drag it directly into the activity’s menu to create a 

new item.  

  NOTES: 

• Be aware that in accordance with the Microsoft default for the drag/drop function, 

this method clips the selected audio/text from the original item and places it in the 

new item.  

• To drag a copy of the clip without cutting it from the original item, press the 

CTRL key while following the procedure.  

The procedure below describes the steps to create an item from a CAN-8 audio recording. 

The same steps apply to create an item from selected text.  

 

• Open an item that contains the audio you wish to move or copy.  

• Place the mouse cursor at the start of the audio section that is desired.  

• Hold the mouse button down while dragging the mouse across the sound graph to 

the end of the audio section you wish to move or copy.  

• Release the mouse button at the end. The sound selected is highlighted dark 

green.  

• Place the mouse on that darker section, press and hold the left mouse button down  

• With the mouse button still held down drag the selection over the tree menu.  

• An insertion bar will appear in the menu. When the bar is where you wish to 

create the new item, release the mouse button.  
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• A new item has been created from the section of audio, placed where the insert 

bar was. No type has been assigned to this item.  

• Right click on the new item to open its properties box where you can assign it a 

title and an item type.  

Moving Items from A Planner to Another 

The CAN-8 multitab interface allows easy transfer of existing items from one Planner to 

another. There are however a few rules to follow:  

  NOTES: 

• Items currently being edited (item tab opened) cannot be moved. You must first 

close the tab. 

 
• Introduction items, which may be used to divide the lesson in sections, behave 

slightly differently than any other items when cut, moved or deleted. Please 

carefully read the procedure for these items  

• A Planner cannot hold more than 240 items. If the number of items pasted 

exceeds the spaces left in the Planner, the paste command will be aborted. To 

know how many spaces are left in a Planner, place the mouse cursor on the bar 

above the menu as illustrated. The tooltip indicates how many more items can be 

added; in this example, 237 items can be added. 
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Use any of the 3 following methods to move or copy items between Planners.  

Method 1: Copy/paste 

This method consists of copying an existing item from one Planner (Planner A), and 

pasting it in the second Planner (Planner B) where desired: 

• First verify that you have enough space in the planner to accommodate the 

number of items you will add to it. (see Note above)  

• Open the 2 Planners.  

• Select (click once) on the item you wish to copy in the Planner A (use the SHFT 

key to copy more than 1 item)  

• Right click on this item and select Copy in the popup menu. Alternatively, select 

EDIT > COPY from the menu bar  

• Select the tab of Planner B to activate it.  

• Locate where you want to paste your item in the menu  

• Right click under the item at the location you want to paste the item.  

• The insertion bar will appear under the item and popup menu is presented 

 
• Select Paste from the popup menu or EDIT / PASTE from the menu.  

 

  NOTES: 

• Changes made to the copied items will not affect the original copy of the item.  

• The same item(s) can be pasted several times in one or several Planners.  

• To select more than one item at a time for copy or cut, use the usual windows 

multiple selection method. Click on the first item, press and hold the shift key 

down, select the last of the items you wish to select, and then release the shift key.  

 

Method 2: Cut/paste 

Similar in procedure as the copy/paste method. This technique results in items being 

moved from the first plan to another plan: 

• Verify that the planner B can accommodate the extra items  

• Open the 2 Planners.  
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• Select (click once) on the item you wish to move from the Planner A  

• Right click on this item and select Cut in the popup menu or select EDIT / CUT 

from the menu bar.  

• Select the Planner B tab to activate it.  

• Locate where you want to paste your item.  

• Right click at the location you wish to paste the item. The Insertion Bar will 

appear under the item and a popup menu is presented 

.  

• Select PASTE from the popup menu or EDIT / PASTE from the menu bar.  

  NOTES: 

• The items that are cut from Planner A are no longer available in Planner A.  

• The same item can be pasted several times in one or several Planners.  

• Use the menu tooltip to see how many items can be inserted in this Planner.   

 

Method 3: drag/drop 

The third method consists of dragging an item from one Planner (Planner A) and 

dropping it in the second Planner (Planner B) where desired. Items may also be copied 

using this method:  

• Open the 2 Planners.  

• Select (click once) on the item you wish to drag from Planner A.  

• Press and hold the left mouse button on the previously selected item. While 

holding the mouse button, move the mouse over the tab of Planner B.  

• As the other Planner B tab highlights, the screen for Planner B will display.  

• With the mouse button still pressed, navigate over the menu.  

 

The insertion bar indicates where the item will be dropped.  

• When the insertion bar is where the item should be placed, release the mouse 

button.  
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  NOTES: 

• By default, this method is equivalent to the cut/paste method. Items dragged and 

dropped into another Planner no longer show in the original Planner.  

• The drag/drop method can be used to copy items if the CTRL key is held down 

while the item(s) is (are) being dragged.  

• When dragging you may also simply release the mouse button on the tab for 

Planner B. This will place a copy of the item at the end of Planner B's menu.  

• Use the menu tooltip to see how many items can be inserted in this Planner.  

 

Moving Introduction Items and/or their content 

Introduction items are used to section your menu in subsections. In the menu, they can be 

either closed to show only the title of the section or expanded to show the items included.  

• If you wish to move the entire section, first close the Introduction item to hide its 

content, select it, then copy, cut or drag it in the other planner as per the methods 

detailed above. 

  

• If you wish to move only one or some of the items included but not the entire 

section, first expend the section to display the items, select the item(s) to move, 

and copy, cut or drag it using one of the method above.   

 

NOTE: 

If the Introduction item is expanded and you select it, only that instruction item 

will be moved.  
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V - Editing an Activity  

All items in an activity can be edited or deleted at any time. This can be done while the 

students are currently using this activity. Changes made are available to them as soon as 

you exit the Planner.  

 

Care should be taken when editing an activity for which students have already 

submitted recorded answers.  In this case, deleting items or changing the items' type 

will result in the system discarding the previous answers.  

 

Note that once the changes to the activity are saved, there is NO POSSIBILITY to undo 

the changes.  

 

To edit the title of an activity in the main menu, you must log in with the system 

administrator's password and change it, then save the changes.  

 

To edit the items' title, the items' order, their content or options, or to add / remove items 

from the plan, click on the lesson's title in the main menu to select it, open the Planner, 

apply the changes and save the Planner.  

It may be necessary at some point to remove an item, either temporarily, or permanently. 

Any of the two following options can be used for that effect:  

Permanent deletion:  

 

o Locate the item in the menu  

o click ONCE on it to select it, the item's title is highlighted. Clicking twice 

will open the item's tab and prevent you from deleting it.  

o Right click on the selected item to open the contextual menu  

o Select DELETE  
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This can be done while the students are in a lesson, and the item will be removed 

from their lesson menu as soon as they select the Next button. However, deleting 

an item where students have already recorded answers will result in the loss of 

these answers.  

 

  NOTES: 

• You cannot delete the item if it is open for editing. You must close the item 

tab first. When selecting the item in the menu, click only once on the item to 

avoid opening it.  

• If you deleted the wrong item, go to File > Abandon Changes in the top 

menu or exit the Planner and select No when prompted if you wish to save the 

planner.  

• Once the item is deleted and the changes saved, the deletion is permanent and 

non-reversible.  

 

Disable the item to remove it temporarily from the students' view: 

o Click once on the item to select it.  

o Right click on the item to open the contextual menu  

o Select Properties.  

o In the properties dialog box, click the radio button for Disabled.  

NOTES: 

Disabled items remain in the Planner and can be re-activated at any time. All 

answers associated with disabled items are saved and will be accessible when the 

item is re-enabled.  

 

VI - Saving Changes 

Saving the changes made to a Planner comes in 2 steps.  

1. First you must save the changes you made to each item you edited. This save is 

local and not yet accessible to the students. It allows you to exit an item in the 

planner without losing the work you just did and work on other items.  

2. The second step is to save the changes made during that Planner session onto the 

server so that they become accessible to all users.  
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If students are currently using the lesson while changes are being made, the changes, 

once saved on the server, will be presented to the students when they proceed to the next 

item in the lesson.  

Saving the Items 

Any changes made to the content of an item must be saved or abandoned when exiting the 

item.  

 

By default, when exiting the tab of an item that has been edited, a Save / Abandon 

Change option is presented:  

The options are:  

 

• YES: will save the changes to the item. You can reopen the item during the same 

session. The content is saved.  

• NO will remove all changes that were done to the item since it was last saved. It 

does not delete the item from the tree menu. It only affects the content.  

• CANCEL or EXIT will simply abort the EXIT request. The item remains open in 

the Planner; the content is kept the way it was on the screen now. 

You can change your user's preferences to skip these prompts when you exit the items. 

They will automatically be saved when you close the items' tab.  

 

  NOTES: 

• This prompt is not shown if the item has not been changed prior to exiting the 

item.  

• The new content of the item, although saved is not yet available to the students 

until the entire Planner is saved.  
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Saving the Planner 

Planner changes include: 

• New added items to the menu.  

• Deleted items from the menu.  

• Moved items in the menu.  

• Changes to existing item types, names, and assigned marks.  

• Changes in the items' display mode.  

• Changes to the content in items.  

• Changes to the Planner or to the Item options.  

• Added timers.  

The changes are saved when you exit the planner's tab. (click on the exit button of the 

Planner’s interface) 

 

If the planner was new and just populated, or if any of the changes listed above were 

made to an existing activity, a prompt to save or abandon the changes will show upon 

exiting the Planner. Select one of the options available.  

Alternatively, if the changes made are not desired, or items were deleted/moved by error, 

you can select the option Abandon Changes from the FILE menu bar.  
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Since this option is also for edited items, you must close all item tabs in the planner 

before or it will only cancel the changes to the item displayed.  

  NOTES: 

• When selecting Abandon changes for the Planner, all items that were edited or 

created and then saved during the current Planner session are abandoned as well.  

• Changes are available to the students as soon as the Planner is saved.  

• Students who were using the lesson while the Planner was edited do not have to 

exit the lesson for the changes to take effect. The changes to the menu and the 

items will be applied as soon as they select the Next item.  

• When the changes are abandoned, the Planner is restored to its previous state.  

 

VII - Adding content to an item 

Once an item has been created in a Planner, content (text, graphics, video, and sound) can 

be added.  

Adding text 

Text can be entered in Teach, Answer, Read/Record, Example, Verify, Simultaneous, 

Multiple-Choice and Fill in the Blanks items.  

 

  NOTES: 

Introduction, Write and Conversation items do not display text to the students. 

Any text entered in any of these 3 last items will simply be ignored and not 

displayed in the student's interface.  

 

 

The text is displayed in a rectangular window. The size of the window depends on the 

type of the item and the presence of an imported graphic.  
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If an image is imported in an Example, Simultaneous, or Verify item, the text display 

window is reduced to 3 lines. However, more text can be entered, and if so, the text can 

be viewed by scrolling down.  

 

There are several ways to enter text:  

• with the physical keyboard.  

• with a CAN-8 Virtual Keyboard.  

• Import a text document.  

• Drag and drop text directly from a file into the item in the Planner.  

• Copy/paste from another item or from a file (.doc, html, .txt, ...)  

Entering Text Using the Machine's Keyboard 

Characters that are typed in are inserted at the text cursor position. Click on the text area 

to show the cursor and type your text. All the normal display characters can be entered 

from the keyboard. 

• If your machine has several language input mrthods installed, select your 

keyboard language prior to typing in CAN-8.  

• For cursive Arabic or languages that read from right to left, you will have to the 

text option before you start typing. These options are in the top menu of the 

interface under TEXT 

 

 
 

• The cursor keys (Up, Down, Left, Right) move the text cursor in the window.  

• The Home and End keys move to the start and end of the current line in the text 

window.  

• CTRL + C to copy selected text, CTRL + V to paste it, CTRL + X to cut it.  

• The character at the text cursor can be deleted with the Del key.  

• The character to the left of the text cursor can be deleted with the Backspace key.  

• If the text cursor is at the beginning of a text line when the Backspace key is 

pressed, the line is joined to previous line.  
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• Lines that would be too long to fit in the window are broken at a word boundary 

and continued on the next line.  

 

Some languages require a few accented or specific characters. These characters are 

available in CAN-8 if they are not present in your keyboard and can be accessed using 

one of 2 methods: 

Method 1: 

Type the character and then use CTRL + A on the keyboard to cycle through various 

alternatives for that character.  

Method 2: 

• Type a character then right click on the typed character.  

• Select Accent in the popup box. 

 

 
• A list of alternative characters will display. Click on the character in the popup 

selection box. 

 

 

Entering Text Using a Virtual Keyboard 

In other languages where the standard keyboard may not contain the characters needed, 

the course author may define a virtual keyboard that contains the required characters.  
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CAN-8 comes with 20 pre-defined keyboards and a template that allows you to create 

your own. Pre-defined keyboards can be selected and used as they are or can be edited to 

suit the need or layout that the instructor may prefer.  

When a Virtual Keyboard is added in the Planner, the instructor has the option to enter 

text from the physical OR the virtual Keyboard, and thus can use both sets of characters.  

The user toggles between these keyboards by either clicking on the Virtual Keyboard 

interface to activate it, or on the text area to de-activate it. While deactivated, the Virtual 

Keyboard is semi-transparent.  

 

When the virtual keyboard is activated, each key is linked to the corresponding key on 

the physical keyboard. Therefore, the user can type in the language of the virtual 

keyboard using the machine's physical keyboard. The user can also enter text by clicking 

on the desired character key on the virtual keyboard using the mouse.  

 

When using the Virtual Keyboard an accented or alternative version of a character can be 

entered using the following method:  

• right click on the keyboard key  

• then select the character variation you wish to type. 

 

 
 

For information regarding the creation or editing of virtual keyboards and how to make 

them part of a lesson or how to save them on the server please read the Virtual Key 

board section of this document.  



 

33 

 

Importing text from a file 

 

 

Located under the File Menu, the Import > Text option allows you to import the content 

of a text file located either on the local drive, a network share or a removable data storage 

device.  

 

NOTES: 

• This method only applies to files with the extension .txt. You cannot import a .doc 

or a .pdf file.  

• Text fonts not supported by CAN-8 will be replaced by CAN-8 the default font 

when importing.  

• If you wish to preserve the size of the text as it was in the copied document, select 

this option in the Planner tab of your Preference window :  

 
 

Adding text using drag/drop 

Text can also be entered by selecting and dragging the content (or a section) of a file 

directly in the item.  

You can drag/drop text:  

• From a CAN-8 item to a different place in the same CAN-8 item  
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• From a CAN-8 item to another item in the same Planner  

• From a CAN-8 item in a Planner to an item in a different Planner  

• From any word processor document (.DOC, .PDF etc...) into a CAN-8 item as 

long as the word processor support the drag/drop function.  

• From a browser (Explorer, Firefox...) into a CAN-8 item  

1. open the document, CAN-8 tab or web page you want to copy some text from,  

2. drag the mouse over the text while holding the left mouse button to select it,  

3. release the left mouse button and move the mouse pointer over the selected area,  

4. press the left mouse button again and hold it pressed then move the mouse pointer 

to where you want to drop the text,  

5. with the left button still pressed, hold the mouse over the CAN-8 Item's tab to 

activate and display the item,  

6. release the mouse button where you wish to place the text.  

If the document you wish to drag text from and the CAN-8 interface are tiled next to each 

other on your screen,  

 
• Select the text in the document.  

• While pressing the mouse button, drag directly from the document into the text 

area of the item in CAN-8.  

• Release the mouse button to drop the text  

If both interfaces (CAN-8 and the word editor or browser) are layered on 
the screen one above the other:  
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• Select the text with the mouse.  

• left click on the selected text holding the mouse button down.  

• Drag the mouse cursor over the CAN-8 icon or tab in the task bar and hold it 

there until the CAN-8 interface displays on your screen. 

 
• Place the cursor over the item tab in the CAN-8 system you wish to drop the text 

into if it is not already displayed.  

• Finally drag the mouse pointer into the text area of the CAN-8 item and release 

the mouse button. A copy of the selected text will appear.  

To drag/drop text from an item to another item in the same Planner:  

• Select the text.  

• Drag it over the item tab you wish to drop it in.  

• The item will then display, and you can place the drag cursor where the text 

should be dropped.  

• Release the mouse button to drop the text.  

To drag/drop text from a Planner to another Planner 

• Select the text.  

• Drag it over the Planner tab you wish to drop it in and hold it there until the target 

Planner displays.  

• Still pressing the mouse button down, hold the cursor over the item tab you wish 

to drop the text in and hold it there until the item displays.  

• Place the drop cursor where you want the text.  

• Release the mouse button.  

 

 

NOTES 

• Text font not supported by CAN-8 will be replaced by CAN-8 default font when 

dropping.  

• Some websites do not support drag/drop of their content. Instead of the selected 

text being dropped, you will see the URL (http://...). If this is the case, use the 

copy/paste method.  

• If you wish to preserve the size of the text as it was in the copied document, select 

this option in the Planner tab of your Preference window: 

 

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/plannerm.html%23op0024
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Copy > Paste text from a document or browser 

Text can also be entered by selecting and copying the content (or a section) of a file and 

pasting it in the item.  

You can copy/paste text:  

• From a CAN-8 item to a different place in the same CAN-8 item  

• From a CAN-8 item to another item in the same Planner  

• From a CAN-8 item in a Planner to an item in a different Planner  

• From any word processor document (.DOC, .PDF etc...) into a CAN-8 item.  

• From a browser (Explorer, Firefox...) into a CAN-8 item if the website allows 

their content to be copied.  

1. Open the document, CAN-8 tab or web page you want to copy some text from,  

2. drag the mouse over the text while holding the left mouse button to select it,  

3. release the left mouse button and move the mouse pointer over the highlighted 

area,  

4. press the right mouse button to open the contextual menu and select copy or use 

the CTRL + C keyboard shortcut.  

5. click on the CAN-8 item you wish to paste the text in at the position you want the 

text to show.  

6. you can then right click and select paste, go to Edit > Paste from the top menu or 

use the CTRL + V keyboard shortcut.  

 

 

  NOTES: 

• Text font not supported by CAN-8 will be replaced by CAN-8 default font when 

pasting.  

• Some websites do not allow their content to be copied. You will not be able to 

select the text you wish to copy.  

• If you wish to preserve the size of the text as it was in the copied document, select 

this option in the Planner tab of your Preference window: 

 
 

Editing/Formatting Text 

Special tools for editing text are found under the Text menu and the Edit menu in the top 

menu bar. 

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/plannerm.html%23op0024
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Text may be altered by selecting the text with the mouse (dragging the cursor over the 

text or a portion of it) and selecting an edit function. In this manner text can be cut, font 

size changed, type of font altered, and text deleted.  

Sync and colour options. 

 

In the first section of this menu, the 3 first functions relate to text/audio synchronization 

or are used when creating Multiple-Choice questions and fill in the blank questions. Their 

use is detailed in the section related to these items.  

To draw attention to a specific part of the text, a word, a sentence, or part of a word, you 

can highlight it to make it stand out: 

 

 
 

To do so, place the text cursor at the start of a word and then, select Highlight. The 
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word to the next space will be displayed in green. Alternatively, drag the mouse over 

a sentence or a text section and select Highlight to have that section highlighted 

 

 

Font type and size. 

 

By default, the text typed pasted or dropped in a new item is set to medium serif. You can 

however change the choice of font, the font size and the text direction before typing.  

There are several text sizes to choose from as well as 2 types of fonts (Serif and San 

Serif).  

Text direction  

 
 

In some languages text is written from right to left. Select the to left option in the Text 

menu to orient the cursor and the text flow direction for writing in these languages.  

This section also offers an Arabic Cursive Text option. This option is unique to Arabic-

like languages and has no effect on any other language other than to align the writing to 

the left. In Arabic-like languages however this option formats the proper cursive script 

display, as Arabic character vary depending on the character directly before or after them.  

Show Tab stops 
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Is used to change the default size of the Tab. It can be used for example when creating a 

table with columns of different width. 

o Select Show Tab stops  

o A blue vertical cursor will show at the left edge of the text area  

o Drag the blue cursor to where you wish the first column to start  

o Repeat this step for as many times as columns you want to create.  

o Once these tab stops are in place you can move the text cursor from one 

tab to the next by simply using the Tab key of your keyboard.  

Adding a recording or an audio file. 

Sound can be added in any of the available items but will be displayed or will behave 

differently depending on the item type. To add audio in CAN-8, you can:  

• Record a sound using a microphone.  

• Import audio files using the import function.  

• Drag/Drop audio files into an item in the Planner.  

• Copy/Paste or Cut/Paste sound from a file or from a CAN-8 item  

 

NOTES: 

• The maximum length for a recording or an audio file in an item is 40 minutes.  

• Sound files in .wav, .mp3 and certain .wma format can be imported into the 

CAN-8 system. The .wav audio format must be PCM at 44.1, 22.5 or 11.25 

KHz.  

• Although you may grab files from a CD ROM, they have to be in a supported 

format. Native CDA files as found on regular audio CD disks cannot be 

dropped into CAN-8. You will need to convert them in a supported format 

first.  

...  

 

As sound is recorded or imported, a volume graph (in green) is drawn across the screen. 

 

 
 

The volume graph shows the loudness of the recorded sound. This helps in judging how 

loud to speak or in adjusting the playback volume of other sound sources which might be 

attached to the sound input of the computer. The sound recorded should come close to the 

top of the graph but should not touch the top. This causes a distortion that sounds like a 

loud click in the recorded audio.  

 

The volume graph is useful in achieving a consistent level of recorded sound across 

multiple lesson items. Once the student has adjusted the play volume at the start of a 
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lesson, it will not have to be changed again for each item. The volume graph also helps 

the course author locate the beginning of words when synchronizing text and sound.  

Recording sound with a microphone 

 

 

NOTES: 

When recording from a microphone: 

• Always use a good quality microphone.  

• Ensure the environment you are recording in is quiet.  

• Place the microphone as far as possible from the computer to minimize 

machine noise from fans or other devices.  

• While recording, observe the volume graph and ensure that the green sound 

graph reaches approximately three quarters of the total height of the grid 

during loud parts. Adjust the microphone settings if the recording is too loud 

and the green audio graph touches the top or move the microphone away from 

you.  

• Review and edit the recording to minimize pauses and noises at the beginning 

and end of the green graph.  

...  

 

To start recording, select one of the 3 options: 

• Press the Record button. The same record button is available from the interface 

main menu bar, or from the volume graph button bar.  

  
• You may also use the RECORD option under Controls in the menu bar:  

o New Recording: Starts a new recording. Will erase any previous 

recordings made.  

o Continue Recording. Will append recording to the existing recording  

 

 
 

 

• use the F3 key from the keyboard.  

 

To stop recording: 

• Press any Pause button available on the screen.  
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• Select the Pause option under the Controls menu. 

• Press the F4 key on your keyboard. 

• Recordings can be resumed by pressing  

o the F3 or F4 key  

o Selecting> the Continue Recording option under Controls > Record top 

menu  

Importing Audio Files  

 

NOTES: 

You can import audio files in WAV, MP3 and WMA format. Native CDA files, 

as found on regular audio CD disks, cannot be imported into CAN-8. You will 

have to convert them first using a software such a Windows Media Player.  

...  

 

 

 
 

To import an existing sound file directly into CAN-8 select Import --> Sound from the 

File option in the menu bar. A file selection dialog will allow you to browse to the 

location of the sound file you wish to import.  

The imported sound file will be appended to the end of any currently recorded sound 

shown in the volume graph.  

Drag/Drop Audio Files 

Sound files in WAV, MP3, WMA can be dragged and dropped into the CAN-8 system. 

 

 

NOTE: 

Native CDA files, as found on regular audio CD disks, cannot be dropped into CAN-8. 

You will have to convert them first using a software such a Windows Media Player.  

...  
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1 - If your open windows are tiled:  

 
• Locate the file you wish to import into CAN-8.  

• Click once on it to select it - do not release the mouse button.  

• While holding the button down, move the mouse cursor on to the item's sound 

graph.  

• Release the mouse button to drop the file.  

2 - If your windows are superimposed. 

• Locate the file you wish to import into CAN-8.  

• Click once on it to select it - do not release the mouse button.  

• Move the mouse cursor so that it is on top of the CAN-8 icon showing in your 

task bar. 
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• Hold it there for a few seconds - this will display the CAN-8 interface.  

• Without releasing the mouse button, move the mouse cursor so that it is either on 

top of the desired item tab in the Planner interface, or directly into the audio graph 

if the item is opened as illustrated in the previous example  

 

 
• Release the mouse button to drop it. 

The audio can also be dropped into the Planner treeview menu which will create a 

disabled item containing the audio.  

3 - If the audio is in a CAN-8 item. 

WARNING:  

This method does not copy the sound section, it clips the selected part of the 

audio and places it in the other item.  

...  

 

• Open the item that contains the original audio.  

• Place the mouse cursor at the start of the audio section to clip and right click.  

• Hold the mouse button down while dragging the mouse across the sound graph to 

the end of the audio section you wish to move. As you move the mouse the 

selected audio is shown in dark green. 

 
• Release the mouse button. The sound section selected remains dark green.  

• Left click once on that section, holding the mouse button down. (If you click but 

release the mouse button, the selection will be cancelled)  

• Drag the selection over to the item tab you wish to place the sound in. Hold the 

mouse over the tab until the item's interface is displayed.  

• Move the mouse cursor to the volume graph and release the mouse button.  

• The sound section will appear in the Volume graph at the location selected.  

Copy/Paste or Cut/Paste sound 

1 - To copy an audio file from a drive 

• Locate a file on your drive, then right click on it to get the contextual menu or left 

click once on it and select the EDIT option in the menu bar.  

• Select Copy or Cut  
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• Place your mouse over the volume graph window in CAN-8.  

• Right click and select PASTE in the popup menu or select EDIT > PASTE in the 

menu bar of the CAN-8 interface.  

 

 

2 - To copy or cut a portion or all the audio located in another CAN-8 item: 

• Open the item you want to copy or cut the audio from.  

• In the volume graph, click at the beginning of the sound you wish to copy, hold 

the mouse button down while dragging the mouse cursor to the end of the audio 

section you want.  

• The section selected will be displayed in a darker green.  
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• Right click on the selected section and choose COPY or CUT from the popup 

menu.  

 
 

Alternatively, you can select EDIT > COPY (CUT) from the CAN-8 interface 

menu bar once the audio is selected.  

• Open the item you wish to paste the sound in.  

• Right click on the volume graph at the location you wish to place the sound and 

select PASTE in the popup menu. If you do not care where in the volume graph 

the audio is placed, you may also choose EDIT > PASTE from the CAN-8 

interface menu bar.  

 

Playing Sound 

1 - To play the recorded or imported audio: 

• Press the Play button located in the button bar or on the volume graph.  

 
• You can select one of the Play options under Controls in the top menu.  

• You can also press the F2 key of the keyboard.  

• And finally, you can play the audio by double clicking on the volume graph  

As the sound is played, the play cursor line (red and yellow) moves across the sound 

volume display.  

2 - To pause the sound at a specific place:  

• Press the Pause button.  

 
• Select the Pause option under Controls in the menu bar.  

• Press the F4 key on your keyboard.  
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3 - Playing can be resumed by:  

• Pressing the Pause button or the Play button again.  

• Selecting the Play option under Controls in the menu bar.  

• Pressing the F2 or F4 key on the keyboard.  

Editing Sound  

There are several reasons for editing sound. In many cases the microphone used for 

recording picks up the sound of keys on the keyboard or the sound of taking a breath 

before speaking and you may want to remove these noises.  

There might also be a need to remove part of an audio file or to split an existing audio file 

to create several items.  

 

In almost all cases it will be necessary to edit the audio that has been recorded or 

imported in order to create a good quality lesson.  

 

The audio is edited using the volume display and the mouse. The primary method of 

editing audio is to remove unwanted parts, or to move sections of audio from the current 

item to another item. How to move sound from one item to another was covered in the 

Drag/Drop Audio Files chapter. The following section details how to remove unwanted 

sound:  

• Locate in the volume graph the part of the sound you wish to remove. You can 

locate it visually, or you can use the counter situated at the bottom right of the 

volume graph.  

 

 
 

• Click at the beginning of the section to be removed, hold down the mouse button 

on the volume display, then drag the mouse across the volume graph till the end 

of the section, leaving behind a darkened area. This area marks the sound to be 

removed. The sound to keep remains in bright green.  

• Delete that section using the DEL or Backspace key of the keyboard, or by 

selecting the Snip option under EDIT in the top menu. The dark green 

highlighted section of the sound will be removed.  

 

When possible, the sound should be cut at quiet parts indicated by an area in the graph 

with the lowest possible height. If the sound is cut during loud sections, clicking sounds 

may result in the final sound where the remaining parts joined.  
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Synchronizing Text and Sound 

Synchronizing the text and the sound builds links between the words in the text window 

and the sound in the volume display. As the sound plays, the corresponding synchronized 

words in the text are highlighted in turn. When the audio graph is clicked on, the sound 

starts playing from that point and the synchronized words display from that location in 

the sound. Likewise, clicking on the synchronized text plays the corresponding audio 

from that point on.  

 

 
 

Any text can be synchronized, from single letters and spaces, syllables and words to 

entire line of text. 

 

   

NOTES: 

Synchronization establishes a one to one correspondence between the text and the 

sound. The chronological order of the sound must be maintained in the text:  

• It is not possible to synchronize the text from beginning to end with the audio 

from end to beginning.  

• It is also not possible to synchronize a word in the text to more than one 

different place in the sound display. The word must be repeated twice in the 

text to be synchronized to two occurrences in the sound.  

...  

 

The procedure below must be executed in the exact order given.  

 

To synchronize the text:  

 

1. Locate in the audio graph the sound you wish to synchronize possibly by re-

playing the audio until you can see where in the graph the word you want to 

synchronize is located. The graph counter may be helpful to remember the exact 

position of the audio.  

2. In the text area, click in front of the word or text to be synchronized  

3. Click on the volume graph where the matching word begins.  

4. Select TEXT > SYNC TO SOUND in the top menu. The text will highlight in 

cyan to the end of the line.  

5. Repeat these steps for each word/sentence you wish to synchronize.  

 

If you wish to synchronize a syllable, or part of a word, select the syllable by dragging 

the mouse over, then follow the remaining steps to synchronize.  

Repeat steps 2 to 5 as many times as you need while proceeding in a forward direction 

(left to right, beginning to end) through the text and audio.  

Synchronizing is done a line at a time. It is not possible to go backwards and synchronize 

words that appeared before the last synchronized word.  
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  NOTE: 

To remove text synchronization, select EDIT > CLEAR > SYNC in the top 

menu.  

 

 
...  

Emphasized text 

The TEXT > EMPHASIS option, like the SYNC TO SOUND option, also establishes a 

one to one correspondence between the text and the sound in a chronological order.  

 

Similar to the Synchronize to Sound option, the user can click on the text to hear the 

corresponding sound, or click on the audio graph to view the corresponding word.  

 

The procedure to link the audio and corresponding text is similar to the procedure used to 

synchronize them, and the conditions are the same.  

1. Locate in the audio graph the sound you wish to emphasize possibly by re-playing 

the audio until you can see where in the graph the word you want to synchronize 

is located. The graph counter may be helpful to remember the exact position of 

the audio.  

2. In the text area, click in front of the word or text  

3. Click on the volume graph where the matching word begins.  

4. Select TEXT > Emphasis in the top menu. The text will highlight in red to the 

end of the line.  

5. Repeat these steps for each word/sentence you wish to emphasize.  

When the text is emphasized and the corresponding audio is playing in the student 

program, the text is displayed in red font and highlighted yellow. However, contrarily to 

the synchronized text that returns to its original black font when the synchronization has 

moved over, once the emphasis highlight has moved on to another part of the text, the 

previously emphasized text remains in red font.  
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NOTE: 

To remove text emphasis, select EDIT > CLEAR > SYNC in the top menu.  

 
...  

 

Adding Graphics 

A graphic can be imported and displayed as part of the content of an item or as a 

background for a lesson.  

 

The graphic must be a JPG, BMP or a GIF (stored in the GIF 87 format). GIF files 

must not be of the interlaced type. If the graphic is in some other format, it must be 

converted to a supported format using a conversion utility or a drawing package.  

 

Images are restricted to a maximum size of 320 pixels horizontally and 240 vertically. 

Images sized 320X240 will display entirely. Larger sizes images will be cropped to these 

dimensions and thus only the top left corner will be displayed while the rest is discarded.  

 

There are different options to import graphics:  

• Use the Import function from the menu.  

• Drag and drop a file from a disk, a browser or another CAN-8 item.  

• Copy/paste the image from a browser, a file or another CAN-8 item.  

Importing images 

To import an image, access the File option from the menu bar, select Import and then 

Image  



 

50 

 

 

 
 

 

  NOTE: 

 

You must open a Planner and an item first or this option will be greyed out.  

 

  

 
 

The import image window allows you to browse for the file of your choice. 

 

It may be necessary to use the drop-down menu to select the appropriate file type. 
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Once the file is selected, it will display in the item.  

Drag/drop Image 

You can drag and drop an image directly into a CAN-8 item. 

 

 
 

1. Locate the image file on the disk or removable storage device, click once on the 

image to select it, and while holding the mouse button down, move the mouse 

cursor over the CAN-8 interface as illustrated.  

2. Release the mouse button to drop the image in the item.  

3. The same steps are used to drag/drop an image from a browser. Simply select the 

image by clicking once on it, then while holding the button down, move the 

mouse cursor over to the CAN-8 interface and the CAN-8 item, then release the 

mouse button. The image will appear.  
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  NOTES: 

• The image is always pasted in the graphic area, independently of where the 

cursor is placed.  

• When dragging a file from an internet browser, the file has to fit the size and 

format requirements.  

• Some websites will not allow their images to be dragged. When attempting to 

drop them, you will instead obtain the URL pointing to the image 

(http://www.website.com/.../)  

• Once the image is dropped into a CAN-8 item, it is then converted into CAN-

8 format and saved in the item file. The original is no longer required.  

...  

Copy/paste Image 

An image can be copied then pasted from either a file on the hard drive or removable data 

storage device, or from a browser.  

1. Locate the graphic you would like to place in your item.  

2. Right click on it and select copy in the contextual menu.  

3. In the CAN-8 interface, select the item you wish to paste the image in by having it 

displayed on the screen  

4. Right click on the displayed item and select Paste from the popup menu.  

Alternative methods can be used, such as: 

1. EDIT > COPY in your browser, or your explorer menu bar, then EDIT > 

PASTE in CAN-8.  

2. CTRL + C on your keyboard to select the image and CTRL + V to paste it in 

your other item.  

 

  NOTES: 

• The image is always pasted in the graphic area, independently of where the 

cursor is placed.  

• When pasting a file from an internet browser, the file has to fit the size and 

format requirements.  

• Once the image is dropped into a CAN-8 item, it is then converted into CAN-

8 format and saved in the item file. The original is no longer required.  

• You can COPY/PASTE an image from another CAN-8 item using the same 

procedure.  

...  

 

Link a video file to an item 

This section describes how to play video as a part of CAN-8 lesson item, the 

requirements, and file formats.  
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Video File Types 

  

 NOTE: 

Each device used to record a video uses a different method of compression. As a 

result, the proper codecs must be installed on the workstation in order to play the 

video. This is the most common problem encountered when playing video on a 

computer.  

...  

 

Both MPEG and AVI files can be linked in a CAN-8 lesson item, each with their own 

points of merit.  

AVI Files 

AVI files tend to have a wider range of codecs that are used in their compression. This 

means that it is sometimes a challenge to ensure that all workstations are equipped with 

the proper codecs for playing the lesson. The newer Microsoft OS however do have most 

of these CODECs installed by default 

MPEG Files 

Most machines will have the needed MPEG codecs already installed. MPEG files tend to 

be compressed more efficiently and therefore may have a more consistent delivery when 

being played by large groups of students simultaneously.  

 

Variants of MPEG (specifically MPEG-4, but others as well) may also be stored in an 

AVI file using the correct codecs.  

Linking video files 

  NOTES: 

• Unlike sound or picture files, video files are not imported in CAN-8 and 

therefore are not converted in CAN-8 format. The original video must be 

present on the machine, the network or the website it was linked from and 

students must have access to this location from their workstation.  

• Videos will have an impact on the network bandwidth. For an optimal 

experience, favour shorter videos.  

...  

To link a video:  

Choose between:  

• File > Import > Video from the CAN-8 menu bar.  

• File > Import> > Video via URL from the CAN-8 menu bar.  
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• Drag and drop from a shared folder.  

• Copy/Paste from a shared folder.  

From the File > Import > Video Menu 

 
 

If the video is located on a shared network folder:  

1. Access the File option from the menu bar in the Recorder and select Import > 

video  

2. In the Video Import box, select the file type (avi, mpeg or wmv).  

3. Browse and select the file to link to.  

 

 

  NOTES: 

• The video will only play if the student connects from within the school's 

network.  

• If the path from the instructor station is: W:\video\file.avi Where W:\ is a 

network share, and Video a shared folder, this path, including the drive letter, 

must exist on ALL client machines that will be accessing that lesson.  

• If the video is on your C:\drive, the video will not play on the student station 

unless you place a copy of the video on their C:\drive, in the exact same path 

as yours  

...  

From the File > Import > Video from URL Menu 

The file will be played from a webserver instead of a local server and is accessible to all 

remote users. 

 

For remote users, this would be the most effective way to add a video as all students will 

be able to access the video URL.  

 

1. In File option from the menu bar, select Import > video from URL  
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2. In the Select URL box, type or paste the full URL where the file is located. (i.e.: 

http://www.mywebpage.com/video/myvideo.mpg). You must type in the http:// 

header 

 
3. Select OK.  

 

 

  NOTE: 

The remote users' stations must have the proper CODECs installed. It is therefore 

preferable to format the video with CODECS that are already included in the 

Microsoft OS.  

...  

Drag and drop from a shared folder 

• Browse through the folder and locate the file. Make sure the file is of the correct 

format.  

• Click on the file, and while holding the mouse button down, drag the file either 

directly into the CAN-8 item if the software is tiled, or on top of the CAN-8 icon 

in the task bar to open the CAN-8 interface.  

• When the mouse cursor is over the item's text area, release the mouse button to 

drop the file.  
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  NOTES: 

• This method will not work for remote users.  

• The video will only play if the student connects from within the school's network.  

• If the path from the instructor station is: W:\video\file.avi where W:\ is a network 

share, and Video a shared folder, this path, including the drive letter, has to be 

existing on ALL client machines that will be accessing that lesson.  

• If the video is on your C:\drive, the video will not play on the student station 

unless you place a copy of the video on their C:\drive, in the exact same path as 

yours  

...  

Copy/Paste from a shared folder 

• Browse through the folder and locate the file. Make sure the file is of the correct 

format.  

• Right click on the file and select Copy or select EDIT > COPY from your menu.  

• Open the CAN-8 interface.  

• Place the cursor in the text area of the item, right click and select Paste or select 

EDIT > PASTE from the menu bar.  

 

 

  NOTES: 

• This method will not work for remote users.  

• If the path from the instructor station is: W:\video\file.avi where W:\ is a 

network share, and Video a shared folder, this path, including the drive letter, 

has to be existing on ALL client machines that will be accessing that lesson.  

• If the video is on your C:\drive, the video will not play on the student station 

unless you place a copy of the video on their C:\drive, in the exact same path 

as yours  

...  

VIII - Delete Item Content 

The content of an item can be deleted using the Clear option in the Edit menu. This will 

not delete the item from the planner's menu.  

 

The options are: 
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• Clear > All - Will clear all components of the item: audio, text, image, and video.  

• Clear > Sound - All audio components are removed from the item. If the item 

includes an AVI, the audio component of the video will be deleted, the graphic 

part will remain.  

• Clear > Image - Will delete any graphic the item has. If the item includes a 

video, this option will remove the graphic component, but the audio part will 

remain.  

• Clear > Text - The text is removed from the item.  

• Clear > SYNC - Deletes the link between the text and the audio when it has been 

synchronized. The text and the audio remain untouched.  

 

Alternatively, text and audio components can be deleted by dragging the mouse over to 

select it, then pressing the Delete key.  

 

Graphics and Synchronization however can only be deleted using the Clear menu option.  

 

  NOTES: 

• If a video has been imported in the item, it is possible to delete the audio part 

of the video, and keep only the graphic part, or vice versa.  

• If the audio of a video is deleted, then replaced by another recording, the 

graphic part of the video will play while playing the new audio.  

 

IX - Save Item Content 

Any changes related to the content of an item must be saved or abandoned when exiting 

each item.  

 

 

  NOTE: 

Saving the content of the item allows you to close the item tab without losing the 

changes you made to an item. It is done locally and is not available to the students 

yet nor is it saved on the server. The content will only be available to the students 

once the Planner is saved.  
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By default, when exiting the tab of an item that has been edited, a Save / Abandon 

Change option is presented: 

 
 

• YES: will save the changes to the item. You can reopen the item during the same 

session. The content is saved.  

• NO will remove all changes that were done to the item since it was last saved. It 

does not delete the item from the tree menu. It only affects the content.  

• CANCEL or EXIT will simply abort the EXIT request. The item remains open; 

the content is kept the way it was on the screen now.  

 

The default setting can be changed to skip these prompts. The Items will then 

automatically be saved to include the last changes when the user closes the tab. The 

option to abandon the changes to an item will still be available from the File > Abandon 

Changes link in the top menu.  

 

The steps to change these defaults are detailed in the user's preferences section of this 

chapter.  

 

  NOTES: 

• This prompt is not shown if the item has not been changed prior to exiting the 

item.  

• If you select Abandon Changes when exiting an item, this item returns to its 

original content.  If, however, you select Abandon Changes when exiting the 

Planner, all changes done to this Planner during the session are abandoned, 

including the changes done to the items you have saved.  

  

X - Item Types 

An instructor can create up to 11 different types of items, although two of these item 

types only modify the behaviour of the item that follows directly in the plan (Introduction 

and Conversation item).  

 

The format of each item is pre-defined and can include different components, like audio, 

text, graphics, and video. We will address the components of each of these items all 
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throughout this next section as we go through the creation process and details of each 

item type.  

The Introduction Item (I)  

May include audio, graphic  

Does not display text 

Does not display an interface to the student. 

Requires no recordable or written input from student.  

 

In the Introduction item, an oral introduction may be recorded. This recording is then 

played first whenever the lesson is started or a new section of the lesson plan entered.  

 

Introduction items are used to divide the lesson into sections and are represented in the 

treeview of the lesson as submenus.  

 

 
 

This item's behaviour will change depending on the content that it includes. 

• If no content is added, this item is used to divide the lesson into sections or 

chapters.  

• If only audio is added, the audio plays when the student enters the lesson or enters 

a new section in the plan, but no interface is presented.  

• Since this Item is transparent to the student and has no displayed interface, any 

text entered in that item is ignored in the student program.  

• If a graphic is imported into this item (.gif .jpg or .bmp 320x240 pixels in size) it 

will become the background image for the all the following items, until either 

the end of the lesson, or until another Introduction with a different image is 

encountered  

 

The screenshots below show an introduction item in the planner that includes graphic, 

text and audio.  
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This is the same item as shown to the students:  

 

 
 

Note that in the Player (student interface), the text is no longer visible. The image is 

resized to the entire work area and will remain in the background for the rest of the 

section or until the end of the lesson if the next Introduction item does not include an 

image.  

This item's behaviour will also change depending on the content of the item that follows 

it directly.  

• If the introduction item includes an image and one of the items following the 

introduction item also includes an image, the background image will be hidden to 

allow the item's image to stand out.  

• If the introduction item includes an image, and one of the following items 

includes text, the background image is filtered to allow for more contrast.  

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/plannerm.html#but
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• Since the introduction item has no interface in student mode, there is no volume 

graph for its audio. It plays automatically as the student starts the section.  

The examples below show the same Introduction item as in the illustration above 

followed by Teach items with and without graphic.  

Teach item without graphic:  

 

 
 

The background shows trough the item  

Teach item with image included:  

  
The background image from the Introduction item is removed in the student interface to 

enhance the visibility of the image included in the Teach item. This behaviour will apply 

to all item types. The background will show again in items that do not contain an image.  

 

NOTE: Since students cannot submit an answer to introduction items, they do not have 

corresponding cells in the tracker.  

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/plannerm.html#Int
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The Teach Item  

May include audio, text, graphic or video 

Requires no recordable input from student  

A teach item explains a concept or gives instructions about the exercises that follow it. 

The recording screen for a teach item has a large text area and can display a graphic or 

video. The students cannot record nor type an answer in this item.  

 

The screenshot below shows the Planner view of a Teach item with text audio and 

graphic. 

 
 

Same item displayed to the students:  

 

 
 

 

  NOTE:  Since students cannot submit an answer to this item, it does not have a 

corresponding cell in the tracker.  

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/plannerm.html#teap
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The Example Item  

Must include audio  

May include text, graphic or video 

Requires student to: Record an oral answer  

 

In Example items, students must listen to an audio sample then record their own version 

of the example.  

 

As 2 sound graphs are required for the example and for the students' own recordings, the 

text area is limited, specially if an image is also added.   

 

The screenshot below shows an Example item in the planner with text audio and graphic. 

 

 
 

Same item displayed to the students:  

 

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/plannerm.html#Exep
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  NOTES: 

• When an image is imported in this item type, The text display is reduced to 3 

lines at a time. A scroll bar located on the right of the text area allows 

navigating through the remainder of the text.  

• If no graphic is included, the text area expends above the audio players.  

  

The Simultaneous Item  

Must include audio 

May include text, graphic or video 

Requires student to: Record an oral answer  

 

The layout of the Simultaneous item is the same as the layout of the Example item. It can 

include the same components and presents two volume graphs, but the behaviour of the 

item is diff, but the behaviour of the item is different.   

 

The students must record their answer while the example is played. They cannot listen to 

the instructor recording prior to their own recording time. As soon as the Record button 

is pressed, the instructor's pre-recorded audio is played simultaneously, and the student's 

recording begins.  

 

The screenshot below shows the Planner view of a Simultaneous item with text audio and 

graphic. 
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Same item as displayed to the students:  

 
 

 

Note that the Play button is disabled in the sample audio player. The students can only 

press on the Record button.  

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/plannerm.html#simp
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The Verify Item  

Must include audio 

May include text, graphic or video 

Requires student to: Record an oral answer  

 

The layout of the Verify item is identical to the layout of the Example item.  

 

The students must first record then verify their recording against the sample audio 

provided. The sample audio is disabled until the students first record their own answer.  

The screenshot below shows the Planner view of a Verify item with text audio and 

graphic. 

 

 

 
 

 

 

 

 

 

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/plannerm.html#verp
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Same item displayed in the students’ program 

 

 
 

The Read and Record Item  

May include text, graphic, video 

 

The Read and Record item does not include audio, therefore no audio example or prompt 

is given to the students.  

 

Although video can be added to a Read item only the visual part of the video will be 

played, the audio will be ignored.  

 

The screenshot below shows the Planner view of a Read item with text and graphic. 
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And as displayed to the students:  

 

 
 

The Ask Item  

Must include audio 

May include text, graphic, video 

Requires student to record an oral answer  

 

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/plannerm.html#readp
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The Answer item requires the student to record an oral response to an oral question.  

 

Unlike the Teach, Simultaneous, Example, and Verify items, the instructor's sample 

audio is not displayed to the student. The student can listen to the question again by 

selecting the example button.  

 
 

The screenshot below shows the Planner view of an Answer item with text, audio and 

graphic. 

 

 
 

Player view of the same item: 

 

 

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/plannerm.html#askp
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The Multiple-Choice Item  

Must include text 

May include audio, graphic, video 

Requires student to select an answer  

 

In a Multiple-Choice item, students are required to select one amongst a few proposed 

written answers.  

 

The text in a Multiple-Choice item consists of a question followed by a few possible 

answers. The instructor can offer up to eight possible choices per question.  

The instructors can also include audio to either repeat the question orally or to present a 

recording or dialog that suggests the correct answer(s) to the question. 

 

The steps below detail the procedure to create a Multiple-Choice item:  

1. Type the question on the first line, then the answers on the following lines. Each 

answer should start on a separate line and can be more than one line 

 

The maximum choices possible per item is 8, the minimum is 2. 

 

 
2. To specify if an answer is correct or wrong, move the text cursor to the first line 

of the answer. Then select Text in the menu bar followed by Tag Answer 
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3. At the beginning of the line, a number will appear in red. A red number 

corresponds to an incorrect choice, a green one to a correct one. 

 
4. Repeat these 2 steps for each line until you get to the correct answer, then select 

TEXT > TAG ANSWER twice and the number will turn Green. 

 
5. Repeat these steps for as many lines as needed for all the answers proposed. There 

can be several correct answers, but the students can only choose 1.  

A warning will be issued if there are no correct answers or less than two answers 

defined in the item. 
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6. If you marked an answer as correct by error, click on that line again, and select 

TEXT > TAG ANSWER. The numbered box will be removed. Then select 

TEXT > TAG ANSWER another time to add the red number. The numbers on 

the boxes automatically adjust when an answer is either added or removed. 

 
 

The proposed answers can be displayed to the student in the order they were typed 

in or in a random order to add some challenge if the students are required to 

repeat the same exercises over. 

By default, answers are randomized.  

 

To remove the randomize option, open the item's properties box and remove the 

check mark in front of the Randomize Answers option. 
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NOTES 

• If you select to keep the Random option, do not add extra text under the last 

selected answer. Any line of text included below that last answers will also be 

randomized as part of the last answer and may be shown out of context.  

• The computer will evaluate and score the student’s answer to Multiple Choice 

Item. If the student selects the correct answer, the computer awards the full mark. 

If incorrect, a mark of zero is awarded.  

• In test mode, if no mark was assigned in the Planner to a Multiple-Choice item, it 

will be treated as a practice question and feedback will be provided to the students 

unless you set the Planner's options to no feedback.  

• If a mark has been assigned to the Multiple-Choice item in the Planner, there will 

be no feedback when in test mode.  

...  

 

The screenshot below shows the Planner view of a Multiple-Choice item with text, audio 

and graphic. 
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Same exercise as displayed to the students 

 

 

The Fill in the Blank Item  

Must include text 

May include audio, graphic, video 

Requires student to write an answer in the blanks provided.  

 

This type of item must contain text. Part of the text is blanked out when it is displayed to 

the student. The student is required to fill in one or more highlighted blanks with the 

correct answer(s).  

 

The steps below describe the procedure to create a Fill in the blank item  

 

1. To create this type of item, first type in the text, including the hidden text that 

specifies the correct answer. 
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2. To select the word that will be hidden from the students, place the text cursor at 

the start, in front of the first letter. 

 

 
 

3. Then select the Tag Answer option from the Text menu in the menu bar. 

 

 
 

4. The word will appear in inverse (white characters on black background).  

If the text cursor was at the beginning of a word, the rest of the word, up to the 

space that separates it from the next word, is marked. 

 

 
 



 

76 

 

5. It is sometimes desirable to mark a field that is bigger than the word (i:e: a word 

and a space character, or an entire sentence) or smaller (a few characters only). 

Place the mouse cursor at the beginning of the characters to hide, then move the 

mouse cursor to the end of the text selection. When the mouse button is released, 

the text selection is highlighted. 

 

 
 

6. If the blank selection needs to be changed, select the blanked text by moving the 

cursor over it while holding the left mouse button down. Release the button once 

the selection is complete. 

 

 
 

7. Then select Normal in the Text menu and the selection will be canceled. 
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This item it is visible from the Tracker screen and can be marked. The computer will 

evaluate and score the student's answer. If a correct answer is entered, the computer 

awards the full mark. If incorrect, a mark of zero is awarded.  

 

The instructor can at any time change the mark assigned by the system from the Tracker.  

 

It might be necessary that the case (upper or lower) of the text be respected as part of the 

answer. If in that item the upper case and lower case are considered important to the 

answer, select Match Case in the properties dialog of the item. When that option is 

checked, answers will be case sensitive. This option is off by default.  

 

When marking a fill in the blank question that includes more than one blank, the 

computer can assign partial marks if the Part Marks option is checked in the properties 

dialog of the item.  

 

 

  NOTE: 

Part Marks and Match Case are set per item, not for the entire Planner. If all 

Fill-in items in a Planner must be case sensitive, this option will have to be 

checked in each of these items as they are created.  

...  

 

The screenshot below shows the Planner view of a Fill in item with text audio and 

graphic. 
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Here is the same item in the students’ interface: 

 

 
 

The Writing Item  

May include audio, graphic, video 

Requires student to type a written answer  

 

This item does not display text to the students, only audio. Text entered by the instructor 

will be discarded in the student's interface.  

 

The Writing item requires a written response from the student, either in answer to a 

dictation or to an open question. The recording button is deactivated in the student's 

interface since no recording can be made. The audio graph is present with the instructor's 

recording, thus allowing the student to listen to the instructions or the dictation over 

again. The audio playback can however be restricted to once, twice or three times via the 

item's properties.  

 

The text submitted is available to the instructor through the Tracker and may be marked.  

 

The screenshot below shows the Planner view of a Write item with text audio and 

graphic.  
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The same item in the students’ program 

 

 
 

Note that the text that was included in the Planner is not visible in the students’ interface.  

 

file:///D:/20210715/Cdrivelaptop/laptop/manual2021/english/plannerm.html#wrtp


 

80 

 

The Conversation Item (C)  

Must include audio only 

MUST be paired with an 'E' or a "V" item 

Does not present an interface to the students.  

 

The Conversation item can only contain audio and is not visible to the students (It has 

no interface). This item must be used in conjunction with Example or Verify items to 

form a dialog and can only be paired with either one of these 2 items types.  

 

The Conversation item is used to play the first part of a conversation, the Example/Verify 

item that follows gives a suggested response or the correct answer. The Conversation 

item must therefore have sound, but graphics and text are ignored  

the Conversation item does not show in the student menu. Only the name of the following 

Example or Verify item is listed as illustrated below:  

 

 

 

Conversation Items in Planner Menu 

 
 

 

View from the student menu  

  

 

 

Items titled 9.2/1, 9.2/2, 9.2/3 9.2/4 are Conversation items. They are paired with the 

items that follow directly (9.2/1a, 9.2/2a, ..., etc) They do not appear in the students' 

menu but will be played when the following Example items are selected 
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  NOTES 

Since the student cannot record an answer in a Conversation item, this item is not 

visible on the Tracker screen; only the following Example item is shown and can 

be marked.  

 

The Disabled Item 

A disabled item is an item with an undefined type. Any item from a Planner can be 

disabled at any time.  

 

  NOTES 

When an item is disabled, the menu entry and the content of the item are hidden 

from the students.  

 

 

An item that has been disabled remains in the Planner's menu as is, unchanged, with the 

formatting of the text, audio and graphic untouched.  

This item can later be re-assigned a type and will again appear in the student's menu as 

soon as the planner is saved.  

Items that are created by dropping or pasting content (audio, images or text) directly in 

the Planner's menu are disabled by default.  

 

You may disable items in a Planner for the purpose of hiding or showing different 

questions to different groups of students at different time.  

 

To disable an item:  

• Select the item in the Planner's menu  

• Right click to bring the properties box  

• At the bottom of the Item Types list, select disable  

To assign a type to a disabled item, follow the same procedure as above, and select the 

type in the item types list.  

XI - The Item Properties 

Item options are set on a per-item basis, therefore only affect the item they have been set 

for. Most are located in the Properties box of the item.  

 

• Select the item. 

• Right click on the item. 

• In the pop-up menu, select Properties. 

• The Properties box will display. 
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Some item options are specific to particular types and are not available to all item types.  

Item Types 

This section lists all the type of items that can be created in a planner. You can change 

the type of the item by selecting the radio button in front of it. However, whereas 

changing an item from an example to a Verify or simultaneous item will not have much 

impact on the format of the item's content, changing it to a Multiple-Choice will require 

some work on the text to add the answer's options.  

 

At the bottom of that list is the option to disable your item.  

A disabled item remains in the Planner as is, unchanged, with the text, audio and graphic. 

It remains in the Planner's menu but is hidden from the students' menu  

This item can later be re-assigned a type and will again appear in the student's menu as 

soon as the planner is saved.  

When dragging or pasting content such as audio or text in the Planner's menu, a new item 

is created. It is however created without a type. You can leave it disabled and use it to 

create other items, or you can assign it a type and format it as needed.  

Item Name 

The title of the item at creation is New item. You can change its name right away, or 

click on it twice slowly in the menu to change it. 
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Alternatively, while changing the item's settings in the properties window, you can also 

change its name in the Item Name field.  

Item Marks 

This option is only available for items requiring a student answer, therefore is greyed out 

for Introduction, Teaching and Conversation Items.  

 

When a lesson is used for test purpose, it might be a requirement to score the tests. 

Although the correction of the item and the marking is done from the tracker, the mark 

the item will be scored out of is assigned per item in the Planner, in the item's properties 

box.  

 

These settings can be added or changed at item creation or any other time by instructors. 

The Planner will have to be saved before they are applied.  

 

 
 

 

In the Item Mark field, in the right corner of the Properties box, select the mark the item 

will be scored out of. These marks are pre-defined by the system.  

_/8 means that this item will be scored out of 8 points.  



 

84 

 

Part marks Given 

 

 
 

This option is only available for Fill-in-the-blank items. It is greyed out for all other 

items.  

Fill-in-the-blank items are evaluated and scored by CAN-8.  

By default, if the students submit a wrong answer to a Fill-in-the-blank item that 

includes more than one hidden word, the entire answer is considered incorrect and 

assigned a mark of 0.  

This option however divides the final score for the item by the number of blanks in the 

question.  

As an example, let's consider a Fill-in-the-blank item marked out of 3 (/3) with 3 words 

hidden; if the student makes a mistake in one of the blanks, by default the score for this 

item will be 0/3. If Part Mark given is checked, the score for the same answer will be 

2/3  

 

Since CAN-8 scores is rounded to an integer number, the results are more accurate if the 

instructor assigns a score for the item that is dividable by the number of blanks. For 

example, on an item with 3 blanks, assign _/3, _/6 or _/9 to have a more accurate score.  

 

 

  NOTES 

• By default, the part mark option is off when items are created.  

• This option is only available for Fill-in-the-blank items.  

• Although Fill-in-the-blank and Multiple-Choice items are corrected by the 

system, instructors can overwrite the system mark in the Tracker and assign a 

different one.  

 

Match case 

This option is only available for Fill-in-the-blank items.  
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At certain times it may be important that the exact upper and lower case characters be 

used to complete the answers in a Fill-in-the-blank question. Fill-in-the-blank items are 

evaluated and scored by CAN-8. By default, upper- and lower-case are considered the 

same and will be marked correct independently of the case used. While this option is 

checked, correct answers will be case sensitive and must match exactly.  

Randomize answers 

This option is only available for Multiple Choice items.  

 

To prevent memorization or copying of answers, the available choices for Multiple-

Choice questions are normally randomized. This means that each time a user enters the 

same exercise, the proposed answer will be displayed in a different order and each user 

taking the test at the same time will see the choices in a different order.  

 

This option is on by default. To remove the option, uncheck it in the item's Properties 

Box. The item's choices will then always be given in the same order as designed in the 

Planner, each time the students encounter this question.  

 

 

  NOTES 

• This is a per item option. It will only apply to the item the option is set in.  

• Do not place additional text or characters below the last choice of the Multiple-

Choice question in the Planner when using the Randomize Answer option, or the 

extra lines of text will also be randomized and will appear between 2 choices.  

...  

Play limit 

This option limits the number of times the students can listen to the audio included in an 

item during a test. This option does not apply to lessons set in practice mode.  

 

 
 

• No limit is the default one. The student can listen to the audio in the item as many 

times as necessary  

• Once only limits the audio to one playback.  

• Up to 2X and up to 3X limits the pay back of the audio to 2 or 3 times 

(respectively) or less.  
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NOTES 

• This option only applies when the lesson is placed in TEST mode. In Practice 

and Review results mode, the student will be able to listen to the audio as many 

times as needed even if this option is set.  

• During playback, the student cannot pause the audio, or go back to a part of the 

audio already played. 

• If the text and sound are synchronized, the text will highlight when the sound is 

played, but clicking on the highlighted text will not replay the audio. 

• Once the limit of playback times has been reached, the student can no longer 

listen to that audio for the remainder of the test, even if the Back option is 

available and the student can visit that item again. This audio is reset every time 

the student takes the test again.  

• This option is available in all item types, including Instruction items.  

•  

XII - Options 

There are several options available which will modify the behaviour of the activities. 

Some are defined per item and impact only the items they are set in, some are defined per 

Planner and modify the entire activity; finally some are defined per user and will only 

affect how the Planner behaves for that user.  

Item options  

Item options modify only the item they are set in and are available depending on the type 

of the item. Most item options are found in the item properties window.  

The timers however, although set per item, will impact the behaviour of the entire 

planner. This option is therefore not found in the item's properties but instead under the 

Options menu. 

The timers 

The CAN-8 system gives you the option to impose time limits per questions or parts of 

lessons.  

 

Timers are accessed via Options > Item > Timer in the top menu bar. The timer option 

is only accessible when a planner is opened, and an item is displayed. It is otherwise 

greyed out.  

Timers can:  

• Limit the time a student spends on the item.  

• Limit the maximum length of a student recording.  

• Enforce automatic sequencing through several items.  

• Prevent the student from selecting other items.  
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The time limit window is composed of 2 main sections:  

 

• The Item View time section - Defines how long the item is displayed on the 

student screen.  

• The Record time section. Specifies the length of the recording allowed.  

The content of these 2 sections will vary depending on the item that is 

currently opened, as some options are not relevant to all item types.  

 

The pairing of different options between sections will result in a different 

behaviour of the system.  

 

The option Students Controls Locked is a separate option that affects the 

students' controls as well as the settings of the timer it is set in.  

 

  NOTE: 

Timers cannot be added to Introduction and Conversation items.  

 

The timer's Item View Time options are:  

• No limit.  

• Sound playtime.  

• Time.  

And the timer's Record time options are: 

• No limit  
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• During play time only  

• set limit time  

• Recording Time Limit.  

Student Controls Locked 

Applies to: All items that include audio or text except Instruction and Conversation 

items.  

 

By default, this option is off.  

 

Student Controls Locked affects all the Control buttons (record, play, next, back, ...) 

while the student is in the item. These buttons as well as the lesson's menu are de-

activated and greyed out.  

 

The Playback, the Recording and the Next buttons are now controlled and automated by 

the system and will be activated in sequence when the time limits set in the timer have 

been reached: 

• The student must view the item for the defined time at which point the recording begins 

automatically and proceeds for the exact time specified.  

• When the timer ends, the item is automatically replaced by the next item, if there are any, 

otherwise the activity is ended.  

• If an item with Students Controls Locked is followed by more items that include timers 

with Student Controls Locked, this same sequence will follow resulting in a fully 

automated activity.  

• If the following items do not have the student controls locked, the controls are released to 

the students who may proceed as they normally do.  

  NOTES: 

Selecting Student Controls Locked also alters the behaviour of the 

other timer settings: 

• If an item includes a Time or Sound Play Time limit and also includes a 

Record Time Limit with Student Controls Locked, the total time for the 

item becomes the sum of the selected time limits.  

• For items that require recorded input, the recording time limit MUST 

therefore be set to a non-zero value or the item will close before the any 

recording can be done.  

• This option is disabled when the item View Time is set to No Time 

Limit.  

Item View Time options 

The Item View Time options let you define how long the item will be displayed to the 

students.  
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No Limit 

Applies to all items  

 

This is the default setting for all CAN-8 lessons. The students can spend as much time as 

desired in the item prior to making a recording. If you pair it with a recording time limit, 

only the recording length will be limited. The students will have to click on the Next 

button to continue.  

  NOTE: 

This option cannot be paired with Students Controls Locked. The lock is 

disactivated or the students would not be able to move on to the next item.  

 

Sound Play time 

Applies to all items that include sample audio except Instruction and Conversation items  

 

The Sound Play Time option limits the display of the item to the time required to play 

the audio that the instructor recorded in the item. As soon as the sound ends, the item is 

replaced by the next one.  

 

The students can record or type their answer while the sound is playing. The item can be 

ended with the Next button before the end of the Sound Play Time. 

 

However, when the Student Controls Locked option is checked, the controls are 

disabled. The students must listen to the item until the complete recording has ended at 

which time this item will close and the next item will display.  

  NOTES: 

• This option limits the time spent in the item to the time that the 

instructor audio would play. It is well suited to automate an item that 

does not require a recorded answer such as Teach and Dictation items, 

or Multiple Choice and Fill in the Blanks questions. The students will 

be required to listen to the instructions or to type an answer while 

listening to the instructor's audio.  

• It is also well suited for simultaneous translation exercises.  

• It would not be suited for any open question type item.  

• If paired with Student Controls Locked and a Record Time Limit, the 

total time for the item view time is increased from the Audio Play 

Time only to the sum of the two limits since the Student Controls 

Locked plays the 2 settings in sequence as seen above.  

• This option is greyed out if the item does not include any audio from the 

instructor.  
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Time 

Applies to all items except Instruction and Conversation  

The format for the fields is MM:ss (Minutes and seconds)  

 

 
 

If Time is selected, the total time spent by the student on the item is limited. The limit is 

explicitly set by filling in the minutes and seconds in the dialogue box.  

 

In this illustration, the student can only spend a maximum of 28 seconds in this item.  

 

  NOTES: 

• If the time counter is not paired with any other option, the student can take the 

item normally. The buttons will function as normal. Recordings can be redone as 

long as it is within the time limit set. The item can be ended with the Next button 

before the time limit set.  

• Once the Time limit is reached, the item will automatically close and the next 

item will display. The recording time can therefore not be greater than the View 

time. It is therefore necessary if you add a Recording Time limit to set the View 

Time to a greater number to accommodate for the recording length.  

• The student can move on to the next item before any of these 2 limits are reached.  

• If the view time is paired only with Students Controls Locked, the students will 

not be able to go to the next item until the time set is reached.  

• If paired with Student Controls Locked and a Record Time Limit, the total 

time for the item view time is increased from the Time set to the sum of the two 

limits since the Student Controls Locked plays the 2 settings in sequence.  

 

Recording Time options 

This section of the timer allows instructors to set a time limit for the length of the 

recording the students can submit.  

No Limit 

Default setting.  

 

When this option is checked, there is no time limit set for the student's recording other 

than the system's limit or the Item View Time Limit if one is set.  
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Recording Time Limit 

Applies to all items requiring a recorded audio answer. 

Does not apply to: Multiple Choice, Write, Fill-in, Instruction and Conversation items  

 

Checking Record Time Limit defines the Maximum length of the student's recording to 

the time specified  

 

The limit is explicitly set by filling in the minutes and seconds in the dialogue box. The 

fields' format is MM:ss  

Used alone, this option allows the student to record as often as desired, but will limit the 

recording length to the time specified.  

  NOTES: 

• If a Record Time Limit and an Item View Time are set without the Student 

Controls Locked, the Item View time limit must be greater than the recording 

limit. If the time allowed is less than the recording time limit, the recording time 

will be cut off.  

• If a Record Time Limit and Item View Time counters are set with the Student 

Controls Locked, the total time for the item is the sum of the two limits since 

Student Controls Locked plays the 2 limits in sequence.  

 

During Play Time Only and Set Time Limit 

These 2 options only show in the timers of Simultaneous items  
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• If during Play Time is checked, the recording time allowed in this item is equal to the 

length of the audio sample recorded by the instructor. As soon as the instructor audio 

stops, the recording time for the student also ends.  

• if a Set time limit is defined, the recording time is equal to the limit defined in minutes in 

seconds.  

 

  NOTES: 

• Care should be taken when setting a value in the Item View Time field for this type 

of item. If the view time is shorter than the recording time limit will be no 

opportunity for the student to complete a recording.  

• If Students Controls Locked is selected, the total time for the item is the sum of the 

two limits since Student Controls Locked plays the 2 limits in sequence.  

 

Items Properties 

Detailed information on how to set the item's properties are available in a previous 

chapter.  

Items properties options are defined per item and specific to certain types: 

The option Randomized Answer for example only applies to Multiple-Choice items as 

they could not apply to a Dictation Item. To prevent any confusion while creating an 

item, only the option relative to the item's types are active and can be selected, the others 

are greyed out.  

 

They are also defined per item. You could have for example 2 Multiple-Choice items in 

the same Planner, one with the randomize option on, one without. Or one scored on _/10 

the other on _/1  

Item properties include:  

• The item type: You can define the item type or disable an item  

• The item's name: You can change the name of any item.  

• Item Mark: select from a list the mark the item will be scored out of.  

• Part Mark given: Reserved to Fill-In-the-Blanks items that have more than one 

hidden word.  

• Match Case: Also reserved for Fill-In-The-Blanks. Checks that the correct case 

has been used in the Student's submitted answers.  

• Randomized answer: Applies to Multiple-Choice only. Presents the item's 

proposed answers in different order ever time the students take this item. It 
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prevents visual memorization of the answers in an activity that is taken more than 

once.  

Planner options 

 

Planner options are found under OPTIONS > PLANNER in the top menu.  

 

They are only active when a Planner is open and displayed on the screen and are 

otherwise greyed out.  

As opposed to item options, which only affect the behaviour of the one item they are set 

for, Planner options apply to the entire Planner therefore they affect every item belonging 

to that Planner.  

 

These options control:  

• The ability for the student to slow down the audio.  

• The compatibility screen size with legacy courseware.  

• The display type of the item.  

• The order the items are presented in.  

• The ability for the student to move back to a previous item.  

• The type of feedback given to the students  

• The access to Virtual Keyboards one can chose from.  

Slow Enable  

 

This option is on by default.  

When this option is on, the students can see the Speed Control Slider on the 

volume graph. They can listen to the audio at a slower or faster speed. The pitch 

of the audio is not affected.  
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To remove this sliding bar, click on the Slow Enabled menu entry to uncheck it.  

Legacy Window Size  

This option is on by default for activities that were created in a version of CAN-8 that 

pre-dates 2010.  

 

It reduces the item display area to the size that the activity was originally designed for, 

thus keeping the text format as originally planned if hard returns were not used to create 

the item.  

 

To remove this option, click on legacy Window Size in the Planner Options menu.  

  NOTE: 

This option should never be used on new activities.  

 

Item Selection 

It changes the order in which the items are presented to the students and the size of the 

display area.  

 

There are 4 possible settings:  

 

 

• Menu  

• Sequential  

• Random  

• Enable Back Button  

These settings will apply to an activity set to either Practice or Test mode.  

 

The illustration below shows how these options affect the display of the items:  
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Menu  

This is the default mode when an activity is created.  

 

In this mode, the tree menu is displayed when the students enter the. The students can 

view and select items from the menu in the order they chose, as many times as they need. 

They can also use the back button.  

 

If the activity is set to Test, students can re-start the test and re-do the items as many 

times as they want to, unless a timer locking the controls is added.  

Sequence 

If Sequence is checked, the treeview menu is hidden. The activity is displayed on the 

entire interface.  

 

The items are presented to the students in sequence and in the order they are in the 

Planner, until the end of the activity is reached. With the back button enabled, the 

students can return to the items previously viewed.  

 

  NOTES: 

• Students do not have the option to choose the items they want to do first.  

• When the  activity is set to Sequence and Test mode, once the students have 

answered all the questions, they can no longer re-access the lesson, nor re-do the 

items.  

• In practice or test mode, if the students skip the first few questions, then record an 

answer in the next items, and exits before the end of the activity is reached, only 

the items that follow the last answer recorded will be presented to the student.  

• However, while in practice mode the students who then reach the end of the 

activity can start again from the beginning and redo the skipped items, in test 

mode the students can no longer access that activity until the instructor deletes 

that users' data from the tracker or places it in Practice or Review Results mode.  

 

Random 

As in Sequence mode, the tree menu is hidden when the activity is set to random mode.  

 

Random mode changes the order of the questions presented to the students. It does not 

randomize the sections that form the activity, only the items within each section.  

This prevents memorizing the order of the answers and maximizes the integrity of the 

tests.  
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  NOTES: 

• If the activity is divided into groups of items (or sections), each separated by an 

Introduction item, the exercises within that group will be presented randomly 

until they are all answered.  

• A student must answer all the items in a section before moving to the next section. 

Pressing Next without answering a question results in the item still being 

available for random selection and the student will be returned to that item after 

others have been answered.  

• The student will not be presented with another section until all items in the current 

section are answered.  

• Once all the all the items in a pool have been answered, the system proceeds to 

the pool of items found after the next Instruction item. In this manner, progress is 

sequential from section to section until the activity is completed.  

• Teaching items will not be randomized. They will be presented first when a new 

section starts.  

• Conversation items are randomized with the item they are paired with since they 

only apply to that item.  

 

Enable Back Button 

This option enables students to return to items that were previous seen.  

 

By default, this option is on.  

 

  NOTE: 

Deselecting this option prevents the student from returning to the previous items 

unless the activity is set to Menu mode since disabling the back button does not 

prevent the user from selecting items in the menu. 

 

Feedback 

Another Planner setting available from the OPTIONS menu is Feedback  
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Feedback applies to Fill in the Blanks and Multiple-Choice items only.  

 

Full feedback is on by default. 

  NOTES: 

• The feedback options usually apply when the activity is in practice mode.  

• Feedback is not offered in an activity placed in test mode unless the questions 

have no mark assigned.  

 

No Feedback 

Does not provide students with any indication if their answer is correct or incorrect. 

 

 
 

Partial Feedback 

Indicates if the answer was correct or incorrect only. Does not provide the correct answer.  

The information is displayed beside the next button: 

 

 
 

Full Feedback 

It is the default option. It indicates if the question was correct or not and displays the 

correct answer if the question was answered incorrectly. 

 

 
 

• For Fill-in-the-blanks items, the correct answers are shown on a green 

background, underneath the student's answers. 
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In this example, the student typed two answers. 

o The first one is wrong, and the green box under the student's answer 

shows the correct answer.  

o The second answer is correct. There is therefore no correction offered.  

 

• For Multiple-Choice items, the incorrect answer selected by the student is 

highlighted red, the correct one is highlighted green.  

 

 
 

In this example, the student selected the answer #3, which is incorrect. The correct 

answer was #2.  

 

If the selected answer is correct, the word Correct will show in the item bar beside the 

Next button. 

 

CAN-8 Virtual Keyboards 

For some languages, the characters required to type in that language are not available on 

the standard keyboard. In other languages, such as Chinese or Japanese, there are more 

characters than may fit on a regular keyboard. In such cases, there are additional 

programs or interfaces that may run on the system known as Input Method Managers.  
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Alternatively, in some languages where all the characters needed can fit on a keyboard 

layout, a virtual keyboard might be simpler to use; they can be edited to suit the needs of 

one specific lesson or language.  

 

CAN-8 provides 20 pre-defined Virtual keyboards that can be used in any Planner and by 

students who use that activity. These keyboards can be used as is or can be edited by the 

activity’s author, and more can be created if needed.  

 

Virtual keyboards that are created or edited can be saved for a one-time use in an activity, 

or saved globally so they remain in the CAN-8 system and are added to the list of 

existing keyboards to be used with other activities.  

 

The following sections will describe the steps to select, edit and use virtual keyboards as 

an instructor in a Planner. Details regarding using virtual keyboards in the student 

program are located in the Virtual Keyboard section of the Student Interface chapter.  

 

Selecting Keyboards 

 
 

From the menu bar, go to Options > Planner > Keyboards, and then Select.  

 

This will display the list of the pre-defined virtual keyboards as well as any extra 

keyboards that have been created by course authors and saved for global use.  

 

Click on the one that you wish to include to the activity.  

 

As soon as the Keyboard is selected, it can be used in the Planner. When the Planner is 

exited, this keyboard is saved within the activity and will show in the student program for 

items that require typed input.  
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• When the virtual keyboard is deactivated, keystrokes from the computer's 

keyboard display in the language defined by the operating system.  

• When the Virtual Keyboard is activated, keystrokes from the computer's 

keyboard show the corresponding characters in the virtual Keyboard.  

• To use the virtual keyboard, the instructor types on the regular physical keyboard 

and the characters shown in those key locations will be displayed as the entered 

text. Alternatively, the instructor can also click directly on each key of the on-

screen keyboard with the mouse to enter the character displayed.  

 

 

To activate the virtual keyboard, simply place the mouse cursor in the text area to define 

where the text should be placed, then click on the Virtual Keyboard's interface. As the 

keys are being pressed on the physical keyboard, they appear highlighted blue on the 

onscreen keyboard.  

 

To deactivate the keyboard, simply click on the text anywhere but on the virtual 

keyboard, and the keyboard will return to its semi-transparent (deactivated) state  
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Combinations of the Shift, Alt, and Ctrl keys can be used to select from up to eight 

different levels of layout in one keyboard.  

 

 
 

A mouse click on one of these three keys locks the key down so that the mouse can be 

used to select another key. The Caps Lock key is used to lock whatever combination of 

shift keys is currently selected. Pressing Caps Lock again will unlock the shift keys. 

 

 
 

Right clicking on a key of the virtual keyboard will display a window with the available 

character variants. The Instructor can then select the appropriate variant by clicking on it. 

It is also possible to type the basic character in the text area, then right click on the typed 

character, and then select one of the variants presented.  

Creating/Editing Keyboards 

In other languages, it is sometimes necessary to define some or all of the keys of a 

keyboard with different characters.  

 

NOTE: 

If this new Keyboard is intended to be accessible in all activities by all instructors 

and be added to the existing list of available keyboards, you MUST sign in as 

MASTER before proceeding with the steps below. (see the Saving Keyboards 

section for more details) 
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The procedures to create a new keyboard or edit an existing one are similar. 

• To create a completely new keyboard, from the menu bar, go to Options > Planner > 

Keyboards, and then New.  

A regular QUERTY layout keyboard will be displayed in the Planner.  

• To change an existing keyboard, from the menu bar, go to Options > Planner > 

Keyboards > Select and then chose one of the existing keyboards.  

To change the keyboard characters:  

• Right click on the key that is to be changed.  

• Select Change Key from the pop-up menu. Note that while the key is being edited, the 

key is red. 

 
 

• In the Character Code window that appears, enter the hexadecimal, 4-digit Unicode 

number corresponding to the character desired to be on that key. 

(Unicode character maps and information may be found at www.unicode.org) 

 
 

• Select OK and the new character replaces the previous one on the keyboard. The key 

background becomes blue again.  

Repeat these steps for every key that needs to be changed.  

 

There are 8 levels to a CAN-8 keyboard:  

• The main one - Unshifted - Typically used for lower case characters  

• The SHIFT - Typically used for upper case characters  

• The ALT  

• The CTRL  

• The SHIFT + ALT  

• The SHIFT + CTRL  

• The ATLT + CTRL  

• THE SHIFT + ALT + CTRL 

You can change or add characters in any of these 8 levels.  
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Once the new keyboard has been created or edited, the changes have to be saved else they 

will be discarded.  

 

Saving Keyboards 

By default, when the instructor adds a keyboard in the Planner, it is saved in that activity 

and will be displayed on the student's screen in any item requiring typed input.  

However, if changes have been made to the Virtual Keyboard's layout, these changes will 

have to be saved to be displayed to the student or to be available to the instructor on 

subsequent access to the Planner.  

 

There are 2 options to save the changes: 

• The first one is to save a keyboard that has been customized for a specific activity 

in that Planner only. In CAN-8 terms, that Keyboard is saved Locally.  

• The second option is to save this keyboard Globally. This assigns a name to the 

keyboard and adds it to the list of available keyboards where it can be selected by 

other instructors, in any activity.  

 

Saving Locally 

When saved locally, the keyboard is saved in the activity it was customized for. This 

implies that this keyboard will not be accessible in any other Planner. 

 
To save locally, select the icon located on the top left corner of the keyboard. This icon is 

only active once a change has been made to the keyboard. The changes are saved as soon 

as the icon is pressed.  

 

 
 

If you have changed the keyboard but not saved the changes a reminder box will show 

when exiting the Planner. If the changes to the keyboard have not been previously saved, 

a prompt will request to save or discard the changes. 

 

 

 

  NOTE: 
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This option is available to users with an instructor ID and to the system supervisor 

(MASTER ID).  

Saving Globally 

If the keyboard that has been customized or designed is intended to be used in several 

activities, then it must be saved globally.  

 

Saving the Keyboard globally will append it to the list of CAN-8 pre-defined keyboards 

so that it can be included in any  

  NOTE: 

This option is available ONLY to users signed in with the MASTER ID.  

Select the global save icon  

 

In order to be appended to the list this keyboard must have a name. At the prompt, type a 

name for that new keyboard in the Title dialog, then select OK.  

The keyboard can now be retrieved by that name from the keyboard list in any other 

Planner.  

  NOTES: 

The global save is only available to the system supervisor. It is not displayed on the 

keyboard if the user signed in with an instructor's ID.  

• If a keyboard was selected and then saved globally after making changes, the 

keyboard name will show in the Title field. If you select OK without changing the 

title field, you will overwrite the original keyboard the CAN-8 system came with. 

A warning will be issued before the changes are accepted.  

• If you name a keyboard the same as one of the existing keyboards you will 

overwrite the existing keyboard with the changed one. Care should be taken not to 

overwrite keyboards indiscriminately.  

• If a keyboard was edited by a user who has instructor privileges and then saved as 

part of an activity, the system supervisor can sign in later and access that Planner 

to save the keyboard globally.  
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Removing a Keyboard from an Activity 

By default, if an instructor opens a keyboard in a Planner, that keyboard will remain 

available in that activity and will be presented to the students entering any item requiring 

text input.  

 

If the instructor wants to remove the virtual keyboard from an activity, simply select the 

X or exit button on the upper right corner of the keyboard before exiting the Planner.  

 

At the warning dialog, select OK to confirm the Keyboard's suppression. 

 

 

Optional Keyboard 

By default, the Virtual Keyboard that is selected in a Planner is the only one the student 

can use. when the students type their answer, the characters typed will be the one from 

the virtual keyboard.  

 

If it is intended that the students use both, the system keyboard in the language defined in 

the system, and the virtual keyboard, with a different set of characters, the virtual 

keyboard must be set as optional. The students can then toggle between both keyboards 

by simply clicking on it to activate it or clicking elsewhere to deactivate it in the same 

manner as in the Planner. 

 

To make the keyboard optional, select Options > Planner > Keyboard from the menu 

bar and then click on Optional. A check mark will show in front of the word Optional to 

indicate this has been set.  
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XIII - Changing User's Preferences 

The Planner's default settings are:  

• Users are prompted to save or abandon changes made to items every time they 

exit the items.  

• When items are added in the tree menu, they remain closed until the user double 

click on it.  

These settings can be changed by the user during or outside a Planner session and take 

effect immediately. They will only apply to that user.  

 

To change the default, select Edit > Preferences in the menu bar and click on the 

Planner tab in the dialog box 

 

> 

• Open Tabs for Items When Created:  

o If this option is unchecked, when items are created in the tree menu, the 

user must then double click on the newly created item to open it so that 

content may be added.  

o If checked, the item opens automatically at creation.  

 

• Save Tabs Without Confirming When Closing Tabs:  

o If left unchecked, the user must confirm each time to save the changes 

made to items after each tab is closed.  

o If checked, the Save prompt does not appear when exiting an edited item 

and the item is saved automatically.  

 

Once the preferences have been adjusted select OK to confirm the new settings.  

This ends the Planner chapter.  

Additional step by step instructions and tutorials are also available in the CAN-8 

Authoring Training Manual. Please contact us to obtain a copy. 
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This concludes the Planner chapter of this reference manual. Other 

chapters are available as follow: 

• player.pdf gives general information about CAN-8 and describes the 

layout of the student program. 

• For information on creating discussion groups, see babilon.pdf 

• For student monitoring and evaluations see tracker.pdf 

• Admin.pdf details the tools available to the system supervisor.   

For technical or software support, renewal of your maintenance agreement or 

information about its status: 

416 968 7155 ext. 502 Toll Free in North America: 

 1 855 305 9937 ext. 502 support@can8.com 


